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About OmniUpdate, Inc.
OmniUpdate® is the leading web content management system (CMS) provider for higher education. The
company focuses on providing an exceptional product and customer experience to its OU Campus™ CMS
users who manage more than 700 web and mobile sites in the U.S. and around the world. OU Campus is
secure and scalable, server and platform independent, and seamlessly integrates with other enterprise campus
systems. It provides college and university web developers, administrators, and marketers with the user-
friendly tools and deployment flexibility they need to achieve excellence. For more information, visit .

About This Guide
The WYSIWYG Editor document provides a PDF version of the Support Site topics regarding the usage of the
WYSIWYG Editor and the tools available for it.

OU Campus Support
The Support site is available to everyone and users are encouraged to visit and browse the site for information.
An institution's administrators are also available if the answer cannot be found on the Support site or further
explanation and clarification is needed. Administrators may contact the OmniUpdate Support Team. Ways to
access the OU Campus support documentation include:

• Support site: http://support.omniupdate.com/
• The help link in the main interface of OU Campus
• The WYSIWYG Help link
• Help links embedded in the system
• Text instructions are provide onscreen for specific fields and functionality
• OmniUpdate Community Network (OCN): http://ocn.omniupdate.com/

Conventions
Shorthand for navigation through the OU Campus CMS is indicated with a greater-than sign and bolded: > For
example, Setup > Sites. Code snippets use Courier New and a shaded background.

http://support.omniupdate.com
http://ocn.omniupdate.com/
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WYSIWYG Editor
WYSIWYG Editor Overview
There are several types of editors available to edit pages in distinctly different ways, but the WYSIWYG
editor is the most common way for users to edit pages in OU Campus. The WYSIWYG (What You See
Is What You Get) Editor allows for a familiar experience of editing a page similar to that of many web
applications and traditional word processors. The WYSIWYG editor allows users to generate HTML content
for specific regions on the page, without needing to program in HTML directly. Note: The WYSIWYG editor
only accepts HTML tags and will strip out server-side or client-side code. If users need to add server-side or
client-side code, they should do so by creating a source code asset or inserting it directly in the source code
for a page.

When logging into the system to directly edit a page, there may be several editable regions available. The
available editable regions are defined by permissions levels and group associations. Only areas that are
available to be edited by that user are shown with an edit button. Clicking on the Edit button above a region
allow for the area to be edited. This opens the WYSIWYG Editor by default and the assigned toolbar is
available.

Keep in mind that part of the configuration of the template design may include an image
in the background that helps present a more accurate rendering of how the content will appear on the page.
It is intended for visualization purposes and to help understand how the content is organized on the page
into editable regions. Once the content has been saved, an actual view of the configured page can be seen
using the Preview mode.

When editing in the WYSIWYG, modifications should be saved by clicking the Save icon before navigating
away from the page. If an attempt is made to navigate away from the page without first saving it, the user
notification is shown as a reminder to save the page.

Toolbars and Tools
Many of the editing tasks for a page such as inserting images and links, applying formatting such as bold,
and spell checking a page can be accomplished from within the WYSIWYG using the toolbar. WYSIWYG
toolbars are customizable and the toolbar the user sees may contain a subset of the available tools as
various custom toolbars can be created and assigned to a user or to an editable region. The Toolbar and
Tools section provides information about the organization of the toolbar and the tools that can be contained
within it. For more information, see:

Toolbar and Tools

Additionally, editing behaviors within the WYSIWYG can be influenced by the operating system in use on
the local computer and the browser. These behaviors as well as other WYSIWYG behaviors are detailed on
this page with these topics:

• Save-in-Place
• WYSIWYG Editing Behavior
• Shortcut Menus
• Paragraph Tags and Assets
• HTML5 Schema
• WYSIWYG Customization
• In-Context Editing
• Creating Custom Toolbars
• Mini-WYSIWYGs

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar.html
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Example of WYSIWYG Editor

Save-In-Place
One item that is not represented on the toolbar, but is available from within the WYSIWYG is the ability to
save while editing a page with the keyboard shortcut CTRL+S (PC). This offers users the ability to save the
page without clicking the usual save icon that ends the editing session. Save-in-place saves the page and
allows the user to continue editing. For more information:

Save-In-Place

WYSIWYG Editing Behavior
Several of the tools that apply styling to content within the WYSWYG can be toggled on and off. For
example, if the Format drop-down was used to apply Heading 1, the use of Heading 1 can be deactivated by
deselecting it in the drop-down. Note that when applying a class from a Styles drop-down and then selecting
another class from the Styles drop-down that both styles are aplied to the text. Formatting applied with
the use of the Styles drop-down can also be cleared with the use of the Remove Formatting tool, which is
represented by the Eraser icon on the toolbar.

Editing behavior while within the WYSIWYG can vary from browser to browser. For example, Firefox,
Chrome, and Safari have settings that prevent scripts from invoking the Cut, Copy, and Paste commands,
so the corresponding buttons on the WYSIWYG Toolbar do not function as expected when using browsers
with these restrictions. The keyboard shortcuts (CTRL+X, CTRL+C, CTRL+P for Windows, CMD-X, CMD-C,
CMD-V for Macintosh) do work as expected. 

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/saveinplace.html
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Shortcut Menus
Right clicking on the WYSIWYG area while editing displays a shortcut menu with the following options:

• Cut (CTRL+X): If content is selected
• Copy (CTRL+C): If content is selected
• Paste (CTRL+V): If content is on the clipboard
• Insert/Edit Image
• Alignment: Left, Center, Right, Full
• Insert Form
• Insert/Edit Table

When text is selected, additional items include:

• Insert/Edit Link
• Unlink

Table

Right-clicking within a table provides a list of available table editing and formatting functions as follows:

• Insert/Edit Table
• Table Properties
• Delete Table
• Cell

• Table Cell Properties
• Split Merged Table Cells
• Merge Table Cells

• Row
• Table Row Properties
• Insert Row Before
• Insert Row After
• Delete Row
• Cut Table Row
• Copy Table Row
• Paste Table Row Before
• Paste Table Row After

• Column
• Insert Column Before
• Insert Column After
• Delete Column

Spell Check

When spell check is used within the WYSIWYG, clicking on a word that is flagged as misspelled with red,
squiggly underlining, displays a shortcut menu that includes the following items:

• Suggestions for correctly spelling the word
• Add to dictionary (if enabled for the user)
• Ignore Word
• Ignore All

When the spell checker is toggled on, a shortcut menu for right-clicking is shown specific to the spell
checker, which includes the following functionality:
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• Cut, Copy, Paste
• Spelling and Grammar
• Font
• Paragraph Direction

Not Inserting Paragraph Tags 
The normal behavior in the WYSIWYG Editor is that a user enters some text and presses Enter. This wraps
the appropriate HTML tags around the content, for example <p> tags.

Typing content and saving without pressing enter, allows for the text to be added without the encapsulating
tags.

The Show/Hide Block Elements tool can be used to change the view to include dotted lines and other
formatting marks indicating what block-level element the text is within.

Paragraph Tags and Inserting Assets
Under normal editing circumstances, a user is not likely to never be within a block level element. In other
words, while editing within the WYSIWYG, the cursor will almost always be within a <p></p> tag or other
block-level element such as a heading like an <h1></h1>. The tested best practice to insert an asset into
the WYSIWYG, and to not have it surrounded by <p></p> tags is to perform the actions outlined in either
Scenario One or Scenario Two.

Scenario One

Start with some existing content and the cursor located at the end of the last text in the WYSIWYG, right
after a period. For example: . in the next line: <p>text content.</p>

1. Press Enter/Return twice in the WYSIWYG then use the Up Arrow key once. The cursor is now inside
the first <p></p> tag set. For example:

<p>text content.</p><p></p><p></p>

2. Select Paragraph from the Format menu. This removes the <p> tag set from surrounding the cursor as
follows:

<p>text content.</p><p></p>

3. Select Insert/Edit Asset, choose the asset, and click Select Asset. This creates an asset in the
WYSIWYG without a surrounding <p> tag set as follows:

<p>text content.</p>{{a:xxxx}}<p>&nbsp;</p>

Scenario Two

Start with some existing content and the cursor located at the end of the last text in the WYSIWYG, right
after a period for example: . in the next line: <p>text content.</p>

1. Press Enter once in the WYSIWYG, then press the Space Bar. The cursor is now inside the first
<p>&nbsp;</p> tag set as follows:

<p>text content.</p><p>&nbsp;</p>

2. Select Insert/Edit Asset, choose the asset, and click Select Asset. This creates an asset in the
WYSIWYG inside a surrounding <p> tag set as follows:

<p>text content.</p><p>&nbsp;{{a:xxxx}}</p>
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3. Place the cursor in front (to the left) of the asset at the beginning of the line, and then select Paragraph
from the Format menu. This removes the <p> tag set from surrounding the asset as follows:

<p>text content.</p>&nbsp;{{a:xxxx}}

Now the space (&nbsp;) can be deleted if so desired.

Note: The cursor must be to the left of the asset, if the cursor is on the right edge of the asset, it will not be
able to select from the Format menu. Pressing Return/Enter after the asset, adds a <br /> tag and not a
<p></p> tag set.

Path
When editing in the WYSIWYG, the status bar below the main content area shows the path for the element
where the cursor is currently positioned. For example, when the cursor is within a paragraph, the following is
shown:

Path: p

The following path:

Path:p » strong

...is for the bolded text shown below.

HTML5 Schema
The available settings for the WYSIWYG Editor include setting a default toolbar, URL and image settings,
and the ability to toggle to HTML5 Schema. Enabling HTML5 Schema rather than using the XHTML default,
changes the behavior of the WYSIWYG and the validation of pages. The WYSIWYG Editor creates the
underlying markup based on the chosen schema. Use caution when changing to HTML5 Schema. If other
components of a site are not updated, such as the XSLs, this can lead to the WYSIWYG removing invalid
elements or a page not passing validation at the time of page check or final check.

The use of the name attribute, which prior to HTML5 was used, for example, to help define an anchor, is
invalid in HTML5 and is removed by the WYSIWYG. The ID attribute is now used. To further this example,
when HTML5 Schema is not enabled and an anchor is inserted on a page via the WYSIWYG, the following
markup is added:

<a name="example"> </a>

When HTML5 Schema is enabled, the markup is:

<a id="example"> </a>

Note that the WYSIWYG Editor does not update or correct invalid HTML. If invalid markup such as the
name attribute is added via the WYSIWYG HTML Source Viewer or the Source Editor, it is automatically
removed when the page is opened in the WYSIWYG. The selection of the HTML5 Schema is one of several
WYSIWYG customizations available in the settings specific to a site. For more information:

WYSIWYG Editor

http://support.omniupdate.com/oucampus10/setup/sites/site-settings/wysiwyg-editor.html
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WYSIWYG Customization
In-Context Editing
Part of the configuration of the template design may include a dimmed image in the WSYIWYG editing area.
This is meant to be representational of how the published page is displayed. For example, there may be a
navigational element included, but not editable in this view as it is meant for visualization purposes. Once
the content has been saved, an actual view of the configured page can be seen while previewing the page.
In the example below, the main content area that includes text is being edited, visualization of the global and
local navigation elements are provided, but not editable in this view. For more information about creating
this affect, see:

In-Context Editing

Creating Custom Toolbars
The WYSIWYG and the WYSIWYG toolbar is customizable by administrators of the account and may offer
different functionality to different users on different pages specific to editing different content types. For
information regarding customizing the toolbar:

Toolbars

Access and Workflow

Mini-WYSIWYG
A version of the WYSIWYG Editor is also available when editing Web Content Assets. The functionality of
the tools on a mini-WYSIWYG is similar to that of when using the main WYSIWYG Editor.

http://support.omniupdate.com/oucampus10/site-development/templating-framework/page-tagging/third-level-tagging.html
http://support.omniupdate.com/oucampus10/setup/toolbar/index.html
http://support.omniupdate.com/oucampus10/setup/access-workflow/index.html
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Toolbar and Tools
Toolbar and Tools Overview
Within the WYSIWYG Editor is a toolbar, which has a variety of functions functionality available to the user
to utilize in order to make editing the page easier.

Icons represent the tools. Clicking on any icon performs an action, either directly to the page, or to the
selected text and graphics. Some icons display more options in a drop-down menu, or in a dialog.

The availability of a function is based on the selected items, or the location of the cursor on the page. For
example, if nothing is selected, functions such as Insert Link are dimmed, signifying that this function is not
available at the moment. For the Insert Link function button to be available, the user must first select text or
a graphic.

In many cases, right-clicking offers contextual functions. For example, right-clicking within a table provides a
list of available table editing and formatting functions. Additionally, commonly used control key combinations
are available such as CTRL+X, CTRL+C, and CTRL+V for cut, copy, and paste respectively for PC.

Keep in mind that the account administrator can remove items and create custom toolbars, which can be
assigned to users, sites, directories, pages, and editable regions.

Toolbar Reference 

Each toolbar is organized into three rows and each row has groups of functionality. In the WYSIWYG, the
groups are divided by a vertical line on-screen. The behavior of the icon is specific to the functionality of
the tool. For example, some functionality such as the link tool requires text or another type of content to be
selected before it is available on the toolbar. Other items on the toolbar include icons that are unavailable
until the main feature has been inserted on a page. For example, the Insert/Edit Table icon will be available,
but the other table editing tools such as those to define row properties or delete a column are not available
until a table has been inserted on a page. Some items such as the Insert/Edit Image icon or spell check,
when clicked, provide a dialog with a much more underlying functionality than is readily apparent. One last
type of element that might be available on the toolbar are several drop-down selectors that provide the
ability to style text. 

One item that is not represented on the toolbar, but is available from within the WYSIWYG is the ability
to save-in-place (CTRL+S or CMD-S). This offers users the ability to save the page without clicking the
usual save icon that ends the editing session. Save-in-place saves the page and allows the user to continue
editing. For more information:

Save-In-Place

The following list provides links to the overview pages for each row, links to the major heading on the pages,
and, if more complete information for a tools is available, a link is provided to that page. 

Toolbar Row 1
Save, Save As, Revert, Restore

• Save

http://support.omniupdate.com/oucampus10/images/pages/wysiwyg/toolbar/toolbar.png
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/saveinplace.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/index.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/index.html#file
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• Save As
• Revert (to Last Saved)
• Restore Auto-Saved Content (Auto Draft)

Cut, Copy, Paste, Find, Replace

• Cut
• Copy
• Paste
• Paste as Plain Text
• Find
• Find/Replace

Undo/Redo

• Undo
• Redo

Toggle Spell Checker

Remove Formatting

Font Formatting

• Bold
• Italic
• Underline
• Strikethrough

List, Indents

• Unordered List
• Ordered List
• Outdent
• Indent
• Blockquote

Text Placement (Vertical)

• Superscript
• Subscript

Align, Justify (Horizontal)

• Align Left
• Align Center
• Align Right
• Align Full

Link Tools, WYSIWYG Help Documentation

• Insert/Edit Link
• Create or Modify a Mailto Link
• Unlink
• Insert/Edit Anchor
• Help Icon

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/autodraft.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/index.html#cut
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/index.html#undo
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/spellcheck-dictionary.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/index.html#remove
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/index.html#font
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/index.html#lists
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/index.html#text
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/index.html#align
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/index.html#link
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/links/index.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/index.html#inserteditanchor
http://support.omniupdate.com/oucampus10/interface/common-functionality/icons.html
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Toolbar Row 2
Font Properties (Family, Size, Format, Styles)

• Font Family Drop-Down
• Font Size Drop-Down
• Format Drop-Down
• Styles Drop-Down (Setup topic)

Text Color, Text Background

• Select Text Color
• Select Background Color

Images/Media

• Insert/Edit Image
• Insert/Edit Embedded Media

Miscellaneous Functionality

• Insert Horizontal Line
• Insert Line Break
• Insert Special Character
• Cleanup Messy Code
• Show/Hide Block Elements
• Show/Hide Guidelines/Invisible Elements
• Edit HTML Source
• CodeProtect
• Insert Predefined Snippet Content
• Insert/Edit Asset

Toolbar Row 3
Table Tools

• Insert/Edit Table
• Table Row Properties
• Table Cell Properties
• Row Editing

• Insert Row Before
• Insert Row After
• Delete Row

• Column Editing
• Insert Column Before
• Insert Column After
• Delete Column

• Split Merged Table Cells
• Merge Table Cells

Form Tools

• Insert/Edit Form
• Delete Form
• Element Editing

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-2/index.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-2/format-dropdown.html
http://support.omniupdate.com/oucampus10/site-development/tools/styles-drop-down.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-2/insert-edit-images/image-editor.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-2/insert-edit-media/index.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-2/show-elements.html
http://support.omniupdate.com/oucampus10/pages/edit/source-editor.html
http://support.omniupdate.com/oucampus10/reusable-content/snippets/index.html
http://support.omniupdate.com/oucampus10/reusable-content/assets/index.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-3/index.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-3/index.html#table
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-3/tables.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-3/index.html#form
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-3/index.html
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• Insert/Edit Input Element
• Insert/Edit Select Element
• Insert/Edit Textarea Element
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Toolbar Row 1
Overview
Most of the tools available on the first row of a toolbar for the WYSIWYG are basic text formatting and
linking. The descriptions of the functionality available for each tool is provided on this page. A few of the
features have a more in-depth description; links are provided to those pages.

The tools are grouped on this page as follows:

• Save, Save As, Revert, Restore
• Cut, Copy, Paste, Find, Replace
• Undo/Redo
• Toggle Spell Checker
• Remove Formatting
• Font Formatting
• List, Indents
• Text Placement (Vertical)
• Align, Justify (Horizontal)
• Link Tools, WYSIWYG Help Documentation

File Tools (Save, Save As, Revert, Restore)

Icon Tool Description

Save Click on the Save icon to save
the current file on the staging
server and exit the WYSIWYG
Editor. Remember, it will not be
live on the production server until
it is published. To use save-in-
place, use the keyboard shortcut
CTRL+S for Windows or CMD+S
for Mac.

Save As Click on the Save As icon to
save the current file with a new
file name and exit the WYSIWYG
Editor.

Revert to Last Saved Click on the Revert to Last
Saved icon to undo all changes
and revert the content in the
editable region to its original
state.

Auto Draft Click on the Auto Draft icon to
restore the content to its last
auto-saved point. For more
information:

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/saveinplace.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/saveinplace.html
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Icon Tool Description

Auto Draft

Cut, Copy, Paste, Find, Replace

Icon Tool Description

Cut To remove content from the
document, highlight the content
and click the Cut icon. The
keyboard shortcut is CTRL+X for
Windows or CMD-X for Mac.

Many browsers (specifically
Firefox, Chrome, and Safari)
disable the use of the cut, copy,
and paste commands via the 

WYSIWYG
 toolbar for security purposes.
This is not a function of 

OU Campus
; this is a browser behavior. The
alternative workaround is to use
keyboard shortcuts. 

Copy To copy a content from the page,
highlight the content and click
the Copy icon. The keyboard
shortcut is CTRL+C for Windows
or CMD-C for Mac.

Many browsers
(specifically Firefox, Chrome,
and Safari)

 disable the use of the cut, copy,
and paste commands via the 

WYSIWYG
 toolbar for security purposes.
This is not a function of 

OU Campus
; this is a browser behavior. The
alternative workaround is to use
keyboard shortcuts. 

Paste To paste content on to a page,
click the location the content
should be placed on the page
and click the Paste icon. The

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/autodraft.html
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Icon Tool Description

keyboard shortcut is CTRL+V for
Windows or CMD-V for Mac.

This pastes only valid content,
code, and styling. The paste
automatically switches between
a traditional paste (e.g., pasting
the code when text is copied
from a page in a web browser),
and pasting from Word, removes
the MSO formatting that is not
appropriate for a web site, as
needed. The Paste function
always cleans up the content
to be pasted to remove any
formatting or code that is not
compliant with the requirements
of the WYSIWYG Editor.

Many browsers
(specifically Firefox, Chrome,
and Safari) 

disable the use of the cut, copy,
and paste commands via the 

WYSIWYG
 toolbar for security purposes.
This is not a function of 

OU Campus
; this is a browser behavior. The
alternative workaround is to use
keyboard shortcuts. 

Paste as Plain Text To paste as plain text, click
the Paste as Plain Text icon.
The icon stays selected until
clicked again, and all pastes
going forward until exiting the
WYSIWYG Editor will be plain
text. This removes all formatting.

Find Click the Find icon to search for
text on the current page.

Find/Replace Click the Find/Replace icon to
search for text on the current
page then replace that text with
other text.
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Undo Redo Functions

Icon Tool Description

Undo Click the Undo icon to undo
the last changes made in this
session one by one.

Redo Click on the Redo icon to redo
changes that were previously
undone and should be restored.

Spell Check

Icon Tool Description

Toggle Spell Checker To spell check the region that
is being edited, click the Toggle
Spell Checker tool. Misspelled
words are underlined with a
red, squiggly line. Change the
incorrectly spelled word with the
suggested words provided or
choose one of the other options
provided:

• Ignore the incorrectly spelled
word (e.g., not make any
changes to it).

• Add to the word to the
dictionary: Level 9 and 10
administrators can add
marked words to a site-wide
dictionary, and administrators
can give users Levels 1
through Level 9 the ability to
add words to the dictionary
as well.

Learn more about the spell
checking.

Remove Formatting

Icon Tool Description

Remove Formatting To remove all formatting for a
selection, highlight the text to be
updated and click the Remove
Formatting icon. This returns the
selected text back to the default
settings.

http://support.omniupdate.com/oucampus9/content/wysiwyg/spellcheck-dictionary.html
http://support.omniupdate.com/oucampus9/content/wysiwyg/spellcheck-dictionary.html
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Font Formatting

Icon Tool Description

Bold Applies bold formatting to
selected text.

Italic Applies italicized formatting to
selected text.

Underline Applies
underlined

formatting to selected text.

Please note that underlined text
usually means that a word or
phrase is a link to another web
page. In this case however, the
underline formatting does not
create a link (to create a link,
click Insert/Edit Link).

Strikethrough Applies
strikethrough

formatting to selected text.

Lists, Indents

Icon Tool Description

Unordered list Turns the selected text into an
bulleted list. Example:

• Apples
• Oranges
• Bananas

Ordered list Turns the selected text into a
numbered list. Example:

1. Click the Go button.
2. Enter the text to search on.
3. Click Start.

Outdent To decrease the indent of a
paragraph, click the Outdent tool.
Each consecutive click moves
text further to the left.

Indent To increase the indent of a
paragraph, click the Indent icon.
Each consecutive click moves
text further to the right.
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Icon Tool Description

Blockquote Blockquote is a block-level
element in HTML that can be
used to set-off quotations or to
cite material.

Text Placement (Vertical)

Icon Tool Description

Superscript Formats the selected text as
superscript text.

Subscript Formats the selected text as
subscript text.

Align, Justify (Horizontal)

Icon Tool Description

Align Left Aligns a block-level element such
as a paragraph or a heading to
the left margin.

Align Center Center aligns a block-level
element such as a paragraph or
a heading within the left and right
margin.

Align Right Aligns a block-level element such
as a paragraph or a heading to
the right margin.

Align Full Justifies text making it flush on
both the left and right side

Link Tools, WYSIWYG Help Documentation

Icon Tool Description

Insert/Edit Link To create a hyperlink:

1. Select the text or image for the
link.

2. Click the Insert/Edit Link tool.
If applicable, the dialog contains
existing link information.

3. Click the Browse icon to select
an internal page to which to link.

4. After locating the file, click
Select Link.
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Icon Tool Description

5. Click Insert.

For links to pages internally, a
page should generally be chosen
from a production server, publish
target, or an auxiliary server.  An
unpublished file on the staging
server or publish target can
also be chosen by choosing the
staging server or publish target
from the drop-down, navigating
to the file, and selecting the
HTML version that is available.
Links can also be made across
sites within an account with the
file browser by clicking Sites in
the breadcrumb and choosing
the appropriate site.

For links external to the site, the
complete URL for the resource
can be typed (or pasted) into the
URL field. Optionally, a target
window type and an anchor
name can also be entered.

For more information about links
and linking:

Insert/Edit Link
If Dependency Manager has
been enabled for the account,
dependency tags instead of
URLs are inserted into the
source of the page when
inserting a link.

Create or Modify a Mailto Link To create a mailto link, select
the text or image for the link,
then click the Create or Modify a
Mailto Link icon. If applicable, the
resulting dialog contains existing
mailto information. Properties
for the mailto link can be defined
including the email address
that is provided when the link is
clicked. For more information:

Mailto Link

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/links/index.html
http://support.omniupdate.com/oucampus9/content/dependency-manager.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-1/links/mailto-link.html
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Icon Tool Description

Unlink Select in the hyperlink and click
the Unlink icon to remove a
hyperlink.

Note

: For unlinking anchors, the
Unlink icon works with anchors in
Internet Explorer. It will not work
on anchors in Firefox, Safari, or
Chrome.

Insert/Edit Anchor To create an anchor:

1. Position the cursor where
the anchor should be placed or
select the text or image.

2. Click the Insert/Edit Anchor
icon.

3. In the Anchor Name field,
enter the name for the anchor.
It is not necessary to enter a #
(hash mark).

4. Click Insert.

To modify an existing anchor:

1. Click the existing anchor
shown in the editing area.

2. Click the Anchor icon on the
toolbar.

3. The Insert/Edit Anchor dialog
shows the existing text for the
anchor.

4. Make the modification to the
text and click Update.

The specifics of valid anchor
names can be found in the HTML
specifications:

HTML 4.01

HTML 5

Help Icon The Help icon displays the help
text for the WYSIWYG Editor. It

http://www.w3.org/TR/html401/struct/links.html
http://www.w3.org/TR/html5-diff/
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Icon Tool Description

show help text for all available
functions, not only those limited
to the toolbar being used.
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Saving in the WYSIWYG Editor
Save-in-Place Overview
When working in the WYSIWYG editor, content can be saved without exiting the editor. To perform this
Save-in-Place feature, use the keyboard shortcut CTRL+S (PC) or CMD+S (Mac). This will save any
changes made in the editor to the staging server while allowing the user to continue working.

Save-in-Place
When the user initiates the Save-in-Place feature, there may be a very brief spinning indicator in the
WYSIWYG editor. Once the spinning indicator disappears, the top of the page will display a message
indicating the saving of the page, the user may resume editing the contents of the page.
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Using Auto Draft
Auto Draft Overview
The Auto Draft feature is an automatic time interval, which is approximately one minute, after which a draft
of the current page is saved on the local computer. If the browser quits, the computer crashes, or the user
inadvertently closes the browser before saving a page, the content can be recovered up to 24 hours later
(unless other saves are done before content recovery).

NOTE:

The Auto Draft icon is only shown in browsers that support this feature. 

Auto Draft
Periodically, the Auto Draft icon will spin. This is the Auto Draft feature running in the background to save
a draft of the current contents of the editor. This draft is stored locally on the user’s workstation, and is not
available on the server.

Restore Latest Draft
If for any reason the browser window is closed or lost, the user can come back into the WYSIWYG editor for
the page and click the Auto Draft button to restore the latest auto-saved content. Remember that auto-saved
drafts are stored locally on the user’s workstation, and the latest draft can be recovered up to 24 hours later
(unless other saves are performed before content recovery).

Restore Auto Saved Content
1. Open the same browser on the same workstation that was being used to edit the page. For example, if
the page was being edited in Mozilla Firefox when the connection was lost, the Auto Draft retrieval must be
completed in Firefox and on the same
local system.
2. Navigate to the page that was being edited.
3. Access OU Campus via the DirectEdit link and log in.
4. Click into the editable region that was being edited prior to the loss of connection.
5. Before entering any content into the page, click the Auto Draft icon.
6. Click OK.
7. The saved content is restored. 
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WYSIWYG Spell Check
WYSIWYG Spell Check Overview
Within the OU Campus™ WYSIWYG Editor there is a built in spell checker. Provided that this feature is
available in the selected toolbar being used, utilizing the spell checker before publishing a page helps
increase the professionalism of the site. Currently the spell checker supports five languages, each with
its own custom dictionary. The current languages supported are: English, Spanish, French, Italian, and
Portuguese. These are the same custom dictionaries that are used during Page Check and/or Final
Check. The WYSIWYG Spell Check feature checks the spelling for the editable region that is open in the
WYSIWYG. This differs from the Page Check/Final Check spell check, which performs the spell check on
the complete page prior to being published.

New and custom words can be added to the spell check dictionary on a per site basis. This is a useful
tool for organizations with a set of custom words they do not want to appear marked as misspelled when
using spell check in the WYSIWYG Editor. Custom words that have been added to a site’s dictionary are
omitted by the spell checker tool in the WYSIWYG Editor for any page within that site. Keep in mind that it
is possible that the spell checker in an individual#s browser may still mark the word as misspelled. If a word
has been added to the dictionary, and it is still being marked as misspelled, check the browser's spell check
settings.

The default language is a configuration option, which allows various pages or users to be able to be able
to use by default different language options. The different custom dictionary can be selected from the drop-
down menu.

Once the WYSIWYG Spell Check is toggled on, misspelled words stay highlighted until an action is
performed that corrects the issue. If new words are typed and misspelled, the spell check should be run
again to catch more words.

Correcting Misspelled Words
1. Click the Spell Check icon from the WYSIWYG Editor toolbar. The default language will be used to spell
check the page. However, if the page should be edited in another language click the downward facing arrow
portion of the split button and select another language.

Misspelled words are identified with a wavy, red underline.

2. Click on a word identified as misspelled. This displays a list of words that may be selected to replace the
misspelled word and other options.
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3. Select one of the suggested words or, one of the other options.

Other options are:

• Add to dictionary (if access has been granted)
• Ignore word: Allows just the current instance of the word to not be marked as misspelled
• Ignore all: Allows all current instance of the word to not be marked as misspelled

Note

: Keep in mind that the browser’s spell checker may be active and marking
words as misspelled while the page is being edited. However, only OU Campus’ spell checker references
the OU Campus custom dictionary. To help verify that a word is being marked as misspelled by the OU
Campus dictionary, look to see if the
spell check icon is highlighted. This indicates that the OU Campus spell checker is being used.

Adding Words
Adding custom words to the spell check dictionary is available dependent upon authority level. It is included
automatically for Level 9 and 10 and it can be made available to Level 1 and above users by a Level 10
administrator.

1. Click the Spell Check icon from the WYSIWYG Editor toolbar.

2. Click the misspelled word that should be added.

3. From the shortcut menu, choose Add to dictionary.

When adding new words to the custom dictionary, they will get added to the dictionary of the language that
is set for the spell checker tool. Unless set differently by an administrator, the default language is English.
An additional custom dictionary may exist at the account level.
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Browser Specific Spell Check vs. OU Campus Spell Check
In the WYSIWYG Editor misspelled words can still appear underlined in red (indicating a misspelled word),
even after they’ve been added to the dictionary. The reason for this is that many modern browsers have
spell-as-you-type or automatic spell-checking capabilities built-in. This can lead to some confusion as to
whether or not a word has in fact been added to the dictionary. To eliminate this problem it can be helpful to
turn off the browser#s spell-as-you-type functionality.

Refer to the specific browser help documentation on spell check for Firefox and Google Chrome. Safari also
has a built in spell checker. Internet Explorer requires an add-on. Keep in mind that this is not all-inclusive of
all available browsers, platforms, add-ons, or applications for spell checker options. Should the information
needed not be listed in this help document, please see the help documentation for the browser, add-on, or
application being used.

Disabling Automatic Spell Checking in Firefox
By default, Firefox is configured to automatically check spelling. It can be turned off in the Preferences
window:

1. At the top Firefox menu bar, click the Tools > Options on Windows or Firefox > Preferences on a
Mac.

2. Select the Advanced panel.
3. Click the General tab.
4. Clear the checkbox labeled Check my spelling as I type.
5. Click Okay or exit the Preferences window to save the changes.

http://support.mozilla.org/en-US/kb/how-do-i-use-firefox-spell-checker
http://support.google.com/chrome/bin/answer.py?hl=en&answer=95604
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Disabling Automatic Spell Checking in Safari
By default, Safari is configured to automatically check spelling. Turn it off on the Edit menu:

1. At the top Safari menu bar, click Edit.
2. Click Spelling and Grammar.
3. Click Check Spelling While Typing. If a checkmark is present, spell check is enabled for Safari. If a

checkmark is not present, spell check is disabled for Safari.
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Insert/Edit Image
Insert/Edit Image Overview
The Insert/Edit Image tool is available on the default toolbar for the WYSIWYG Editor. Custom toolbars
can be created and assigned to a user or content region utilizing the OU Campus CMS administrator
functionality; and if so utilized, the Insert/Edit Image tool may not be shown on the toolbar. Note that using
the Images Gadget may also be used to drop an image on a page and will automatically spawn the Insert/
Edit Image dialog.

The Insert/Edit Image tool provides access to a plenitude of functionality related to images, image
management, and code markup for images. At the very simplest, it can be used to link to an image and
provide a description for it, which is usually required. On the other hand, Insert/Edit Image can also be used
to:

• Upload an image and edit it with the Image Editor
• Manually enter a URL of an image to insert on the page
• Browse to an image that was previously uploaded in order to link to it, including the ability to choose from

an auxiliary site
• Provide metadata about an image in the form of an Image Description (alt tag) and Title (title tag)
• Preview an image
• Align an image
• Add space or a border around an image
• Assign a CSS class or styling to an image
• Create an image swap with JavaScript
• Specify an image map

When using the Insert/Edit Image tool, once an image has been selected for insertion on a page, the
WYSIWYG Editor seamlessly provides the HTML mark-up and the dependency tag for the link behind the
scenes. A dependency tag can also be inserted from within the Source Editor. 

In addition to adding an image to a page, the Insert/Edit Image tool includes the Appearance and Advanced
tabs, which provide content contributors with the ability to further manipulate images by entering information
in a field or selecting it from a drop-down. The Appearance tab provides the ability to modify the appearance
of the inserted image with CSS, but without having to know CSS or directly interface with CSS syntax. The
Advanced tab, in a fashion similar to the Appearance tab, provides miscellaneous functionality for image
manipulation with JavaScript and HTML, including the ability to swap images on mouse over, designate an
image map, and add an ID to the IMG tag. For more information:

Appearance Tab

Advanced Tab

Inserting an Image
1. To insert an image, position the cursor where the image should be inserted and click the Insert/Edit
Image icon.

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-2/insert-edit-images/image-appearance.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-2/insert-edit-images/image-advanced.html
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This shows the Insert/Edit Image dialog.

2. The location of the image can be manually entered in the Image URL field, but to take full advantage
of link management, click the Browse icon to browse to the image as in this manner the image will be
assigned a dependency tag.

 

The Select Image modal is shown. 
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3. An image can be selected by doing one of the following:

• Navigating the folder structure via the breadcrumb links. This includes being able to navigate to another
site within the account.

• Uploading an image.
• Uploading and editing an image.
• Selecting a different environment from the drop-down; such as the production server or publish target.

Staging is the default when Binary Management is in effect. 
• Selecting an auxiliary site from the drop-down.
• Filtering by entering one or more characters. The filter is relevant to the file name, including extension. 
• Switching between list view and thumbnail view.
• Previewing in the preview pane by single-clicking.
• Double-clicking to immediately select and insert.
• Viewing the preview pane content details
• Clicking through the Edit Image link to edit an image. After editing, click save to return to the Select

Image dialog. This edits the physical file and can be useful for quick resizing of an image.

4. Once the image has been selected, click Insert. Alternatively, double-click an image in the list or
thumbnail view.

5. From the Insert/Edit Image dialog, enter a value for the Image Description field.

6. Click Insert. The image is shown in the context of the page within the WYSIWYG Editor.

Note: When linking to an image or other binary file from staging the file must be published to production.
This can be accomplished by making sure that the Include Unpublished Dependencies checkbox is
selected.

http://support.omniupdate.com/oucampus10/pages/upload/upload.html
http://support.omniupdate.com/oucampus10/pages/upload/upload-edit-image.html
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Editing an Inserted Image
The details of the image can be modified after insertion on a page by clicking the same Insert/Edit Image
icon, making the necessary edits, and clicking Update.

Dragging a File to Upload

1. As described above, click the Insert/Edit Image tool, and the Browse icon.
2. From the Insert Image dialog, click Upload.
3. Drag the file or files to upload from the local computer to the dialog. (Multiple files may be selected and

uploaded at one time. On a PC, use Control+Click, Shift+Click, or click and drag to select multiple files.
For a Mac, use the Command key to select multiple files.)

4. Alternatively, click the Add Files button to browse and select local files.

5. If necessary and available, chose an access group for the files. This will limit the ability to access the
image to insert it on a page from within the WYSIWYG to members of the group.

6. The ability to overwrite files may be enabled and available by clicking the Overwrite Existing
checkbox.

7. Files may be renamed at this point by clicking Rename, entering the new file name, and clicking OK.
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Note that after renaming a file, the modification can be reverted by clicking Revert.
8. Click Start Upload to upload the files. For a successful upload, the Upload dialog is automatically

dismissed and the uploaded file may now be selected for insertion. 
During the upload the status is shown as In Progress, which may or may not be visible. An error
message is shown if a file could not be uploaded, which may be the case if it does not follow file
naming conventions configured by the site or if the file exists already and the Overwrite Existing
checkbox was not selected.  

Some errors may be fixed by renaming the file or selecting Overwrite Existing and clicking OK and Start
Upload again. When completed, the green success message is display, Done. Click Close and select and
insert the image from the Select Image dialog.

Example of Successful File Upload After Correction

Additional Information and Reminders
• The ability to upload files is inherently available for users, level 6 or above. Lower level users (1–5) can

be granted the rights to upload via the user’s settings. 
• The permission to overwrite files to which they have access can be granted to user levels 1 through 8.
• To import multiple files using only one selection and containing subfolders, use the Zip Import feature.
• Zip Import is available to users Levels 6–8 through the user’s settings.
• Note: All binary files including images are uploaded to the staging server and must be published to the

public-facing web server. Image files can be manually published with any publish action, or if having
been inserted on a page without publishing, the Dependency Manager will provide a checkbox on the
Publish dialog so that any unpublished dependencies are also published.

Decorative Images
Decorative images are images for which no <alt> descriptive image tag is required. Inserting decorative
images must be enabled for each site by an administrator. This can be accomplished from Setup > Sites >
WYSIWYG Editor > Decorative Images. The default, Disabled, means that the Decorative Image checkbox
is not available and that an Image Description must be added. For more information:

Setup Sites > WYSIWYG Editor Panel

Using Decorative Images

Once enabled, the Insert/Edit Image dialog in the WYSIWYG editor allows users to select a checkbox
indicating that the image to be inserted is a decorative image and to omit the image description.

http://support.omniupdate.com/oucampus10/pages/upload/zip-import.html
http://support.omniupdate.com/oucampus10/setup/sites/site-settings/wysiwyg-editor.html
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Toolbar Row 2
Toolbar Row 2 Overview
A brief description of the functionality available with each tool on row 2 of the toolbar is provided in the
tables below. Several of the features require a more in-depth description and links to those pages are
provided also. Content on this page includes:

• Font Properties (Family, Size, Format, Styles)
• Text Color, Text Background
• Images/Media
• Miscellaneous Functionality

The Font Properties drop-downs and the selectors for text color and background color can be toggled on
and off. For example, if the Format drop-down was used to apply Heading 1, the use of Heading 1 can be
deactivated by deselecting it in the drop-down. Formatting applied with the use of the Styles drop-down,
and those for selecting text color and background color can also be cleared with the use of the Remove
Formatting tool, which is represented by the Eraser icon on the toolbar. In other words, if a span has been
applied, it can be removed by locating the cursor within the span and clicking the Remove Formatting tool. It
is not necessary to be in code view to perform this action.

Font Properties (Family, Size, Format, Styles)

Icon Tool Description

Font Family This Font Family drop-down
displays a list of the standard
fonts recognized by most web
browsers. To change the font
of existing text, select the text
and choose a font from the drop-
down list. To start typing new
text with a specific font, position
the cursor where text where
the text should be inserted and
select a font from the drop-
down list, then begin typing. Text
can also be selected and the
formatting applied. Note that the
appearance in the WYSIWYG
Editor may not reflect the newly
applied styling. From the drop-
down deselect the font size to
stop applying it in the WYSIWYG
by clicking on it again. The
markup is added as a span; for
example:

<span style="font-
family: 'book antiqua',
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Icon Tool Description

palatino;">on the bright
plume</span>

Font Size This Font Size drop-down
changes the size of selected
text. Font size properties are
configured by an administrator
and labeled 1 through 7. To start
typing new text with a specific
font size, position the cursor
where text is to be inserted,
select a size from the drop-
down list, then begin typing.
From the drop-down deselect
the font size to stop applying it in
the WYSIWYG by clicking on it
again. The markup is added as a
span; for example:

<span style="font-size:
x-large;">&nbsp;This
is a font size
application.</span>

Format The Format drop-down lists built-
in styles that can be applied to a
selected paragraph. To apply an
element from the Format drop-
down, click within the paragraph
(or select text), and then click the
element from the drop-down. For
more information:

Format Drop-Down

Styles This drop-down sets the style
of any selected text. The styles
available are configured by the
system administrator. Note that
when applying a class from
a Styles drop-down and then
selecting another class from
the Styles drop-down that both
styles are applied to the text. For
example:

<span class="compare
note">This paragraph has
two classes applied.</
span>

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-2/format-dropdown.html
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Text Color, Text Background

Icon Tool Description

Select Text Color The color for selected text may
be selected by using a picker,
using a hexadecimal, chosen
from a palette, or by color name.
Alternatively, if a custom color
has already been selected, click
the icon to apply the text color.
There are 216 color choices on
the palette. To start typing new
text with a specific font color,
position the cursor at the location
where new text is to be inserted,
choose a color by clicking on it,
or by clicking More Colors and
using the color slider, palette,
name selector, or by typing in
the hexadecimal color code
preceded by a number sign, and
then begin typing.

Select Background Color The color for the background
of the selected text may be
selected by using a picker, using
a hexadecimal, chosen from
a palette, or by color name.
Alternatively, if a custom color
has already been chosen,
clicking on the icon applies the
choice. There are 216 color
choices on the palette. To start
typing new text with a specific
font color, click the cursor at the
location where new text is to
be inserted, choose a color by
clicking on it, or by clicking More
Colors and using the color slider,
palette, name selector, or by
typing in the hexadecimal color
code preceded by a number
sign, and then begin typing.

Images/Media

Icon Tool Description

Insert/Edit Image The Insert/Edit Image tool
provides the functionality for
linking to an image by browsing



OU Campus Toolbar Row 2 Page 40 of 91

Icon Tool Description

or by uploading, and allows
for access to the Image Editor.
Additional tabs and fields provide
advanced options for images
such as including styling and
JavaScript. It also includes a
preview. For more information:

Image Editor
Insert/Edit Image

Insert/Edit Embedded Media The Insert/Edit Embedded Media
tool
provides the functionality for
embedding media specific to
several format types to an image
by browsing or by uploading.
Additional tabs and fields provide
advanced options for embedded
media such as specifying
dimensions, setting audio quality
options and Flash options, and
previewing the source. For more
information:

Insert/Edit Embedded Media

Miscellaneous Functionality

Icon Tool Description

Insert Horizontal Line Adds a horizontal rule.

<hr />

Insert line break To insert a line break, click the
Line break icon. This is the same
as entering <br /> into the
source.

Insert Special Character To insert a special character
such as an copyright symbol,
registered trademark, or other
symbol, click the Insert Special
Character icon. The Select
Special Character dialog
provides a selection of 200
special character from which
to choose. Hover or use left
and right keyboard arrows to
navigate the selection. During

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-2/insert-edit-images/index.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-2/insert-edit-images/index.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-2/insert-edit-media/index.html
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Icon Tool Description

the selection process, a preview
of the character is shown with its
name, HTML
character

 reference, and numerical

character

entity

reference.

Click on the icon of the character
to insert into the page. Right
click the symbol and choose
Copy Link from the shortcut
menu, to copy to the clipboard,
which allows the symbol to be
repeatedly pasted on a page.

Cleanup Messy Code The Cleanup Messy Code icon
removes extraneous tags and
adds appropriate ending tags
where necessary. This helps with
cross-browser functionality as
well as being a best practice.

 Show/Hide Block Elements Toggles the WYSWISYG view to
show or hide block-level element
labeling. Each element such
as <p> or <article> is displayed
encapsulated with a thin border
and labeled with a small tag. For
more information:

Show/Hide Block Elements

 Show/Hide Guidelines/Invisible
Elements

The Toggle Guidelines/Invisible
Elements icon adds/removes
the outlines of tables and other
elements, for visual purposes
only.

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-2/show-elements.html
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Icon Tool Description

Edit HTML Source The Edit HTML Source icon
opens a code view of the HTML
source. If a user has been
granted access, there is also an
HTML Source Editor available
for the source code editing. For
more information, see:

HTML Source Editor

CodeProtect Displays the position of server-
side code within the WYSIWYG
Editor represented within the
editing area with the PHP
Symbols icon:

This allows for easy editing of
server side code (PHP only).

Snippets Click the Snippets icon in
order to select preexisting
snippets of HTML or text to
be inserted into the page. The
Snippets available are set by the
system administrator. For more
information:

Snippets

Assets Click the Assets icon in order to
select a preconfigured asset to
insert into the page. For more
information about assets:

Assets

http://support.omniupdate.com/oucampus10/pages/edit/source-editor.html
http://support.omniupdate.com/oucampus10/reusable-content/snippets/index.html
http://support.omniupdate.com/oucampus10/reusable-content/assets/index.html
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Format Drop-Down
Format Drop-Down Overview
The Format drop-down allows for an element to be applied to text by selecting the element from the list.
This allows for the styling for an element to be defined in a CSS file while the user only needs to select
the proper element. For example, heading levels H1 through H6 can be applied to a text selection in the
WYSIWYG. The formatting for the heading levels are defined in CSS for the page, which is what will be
used to created the output files such as HTML. This is also usually reflected in the view that the user sees
while editing within the WYSIWYG Editor.

Depending upon the WYSIWYG schema selection for a site, the Format drop-down displays different
elements. The default is XHTML (not strict) and the following elements are displayed on the list:

• Paragraph
• Address
• Preformatted
• Heading 1 through Heading 6

With the use of the HTML5 schema, added elements are available in the WYSIWYG. The HTML5 schema
can be enabled for a site by an administrator (Setup > Site). When selected, the WYSIWYG Editor expects
to utilize HTML5-compliant HTML, which includes the addition of HTML5 elements and the removal of
invalid elements. This also affects page validation during Page Check and Final Check as page validation is
for the HTML5 specification. The elements available when using the HTML5 schema are:

• Paragraph
• Address
• Preformatted
• Heading 1 through Heading 6
• Block Quote
• Section
• Article
• DIV
• Aside
• Figure

Example of Format Drop-Down

Selecting from the Format Drop-Down
The application of the format can be toggled; clicking from the menu applies or removes the application of
the Format element. To apply an element from the Format drop-down:

1. Place the cursor within an existing block of text, on a blank line, or select the text.
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2. Click the Format drop-down or the arrow for it.

3. Scroll to find the element and click it. This applies the choice.

Removing or Changing the Applied Format
1. Place the cursor within an existing block of text, on a blank line, or select the text.

2. The applied format is shown.

3. Click the currently applied format to deselect it or choose a different element.
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Image Editor
Image Editor Overview
The Image Editor allows images to be resized, cropped, rotated, and resized with zoom directly in the OU
Campus system. Images can be uploaded and edited all in one operation. The ability to edit an image helps
ensure large images are properly resized before being transferred to the web server. Additionally, images
can be saved and renamed. Access to the Image Editor is level dependent. Those who can upload files can
use the Image Editor to upload images and edit existing images, but cannot overwrite any existing image
with the same file name. Those with overwrite permissions are able to replace existing images. The Image
Editor can be accessed using the following methods:

• Within the Pages list view by clicking a linked image
• Within the Pages list view by clicking Upload and using Upload and Edit
• While inserting images on a web page using the WYSIWYG Editor > Insert/Edit Image dialog
• When editing or creating a new Web Content Asset, the mini-WYSIWYG Editor > Insert/Edit Image

dialog
• While inserting images on a page using the Source Editor

LDP Image Galleries are another way users can add images to a site in the OU Campus system. However,
this function is not related to the standard Upload and Edit Image feature and requires that Live Delivery
Platform (LDP) be enabled. For information about creating LDP Image Galleries:

Image Galleries

Image file types support by the Image Editor is browser dependent. The following file types commonly used
for web pages can be edited and saved with the Image Editor with the most commonly used browsers:

• JPG
• PNG
• GIF
• BMP

For a complete reference of browser support for image formats, see:

http://en.wikipedia.org/wiki/Comparison_of_web_browsers#Image_format_support

Image Editor Restrictions and Requirements
When an image is edited through The Image Editor in OU Campus, it will be recompressed once it is saved.
When using lossy file formats such as JPG, this can cause a visible degradation in image quality. As a
best practice, crop or resize images to the exact size needed on the page before importing them into OU
Campus. Furthermore, using images saved in a lossless file format (such as PNG) in the Image Editor will
avoid losses of quality due to recompression. 

The image size is dependent on two factors: the browser and the amount of memory allocated to the
browser by the parent machine. In testing a fairly large image, 13260 x 3955 pixel (27 MB), was used and
rendered in 198 ms. Performance of image rendering is dependent upon each individual user's machine
and Internet connection. In short, every time a user tries to load an image, large or small, jpeg or any other
extension, the image editor relies on the browser to provide the pixel information.

If working with an image that cannot be edited, log out of OU Campus, quit and relaunch the browser. This
will free up browser-allocated RAM and may resolve the issue.

http://support.omniupdate.com/oucampus10/reusable-content/assets/image-galleries.html
http://en.wikipedia.org/wiki/Comparison_of_web_browsers#Image_format_support
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If pictures do not update to the edited version in Preview mode, the Image Editor and web browser might be
clashing. A browser stores copies of pages of visited pages, then displays these stored files upon the next
visit. This way, the browser is not being forced to load the page anew with each visit, which takes more time
than viewing a stored copy. This storage of pages is called a cache. However, this cache can sometimes
pose a problem when viewing the most updated version of a page is needed. Clear the browser's cache to
ensure viewing of the most recent versions of a page. Reloading or refreshing a page in a browser is usually
sufficient and there are more invasive method of clearing all browser data in each browser's settings.

Image Editor Tools
The Image Editor has a predefined set of tools that allow users to customize images as they wish. For more
information about the tools available in the Image Editor:

Image Editor Tools

Image Editing on Upload
Images imported into OU Campus can be edited on import. To edit images when importing: 

1. Click the Upload icon in the Pages list view. 

2. In the Upload dialog, select Upload and Edit Image. 

3. This automatically opens the local computer’s File Explorer (PC) or Finder (Mac). Locate the file and click
Open. 

4. The image is opened in the Image Editor where changes can be made to the file. 

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-2/insert-edit-images/image-editor-tools.html


OU Campus Image Editor Page 47 of 91

5. When all the changes have been made, click Upload. 

6. A dialog will appear. Enter the New File Name for the file, including the extension, and use the browser
to Select Destination Folder. If needed, select the checkbox for Show Files. 
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7. Click Save. 

The user is returned to the Pages list view inside the folder where the image was uploaded. 

Image Editing from Pages List View
Any image file can be edited from the Pages list view. The image editor can be used to edit images already
uploaded to the staging server.
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1. Navigate to the Pages list view by selecting Content > Pages from the global navigation bar.

3. Hover over the target row and click Edit, or click the hyperlinked image name. 

4. The Image Editor will open and the image can be modified. 

Editing Images in WYSIWYG Mode
To edit any image while using the WYSIWYG editor, click the Insert/Edit Image icon in the WYSIWYG
toolbar. Any image can be selected and edited using the Edit Image button in the file selector window.
Additionally, users can upload and edit any image from this same window by clicking the Upload button.

1. Click the Insert/Edit Image icon on the WYSIWYG toolbar.

  

2. Click the Browse icon to change or edit an image.
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3. Expand a folder or double-click to view thumbnails of all the images contained within that folder. Click a
thumbnail to show a preview of just the selected image.
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4. Choose one of the following actions:

• Click the Edit Image button to edit the file displayed in the Image Preview window.
• Click the Upload button to open, edit, and upload a file from a local computer.
• Click the Upload & Edit button to upload a file from a local computer and start the Image Editor.

Final Notes
The edited image must be republished in order to appear correctly on the rendered webpage. This may be
initiated with a page publish by selecting the checkbox to publish unpublished dependencies. Or it may be
necessary to manually publish the image. If the image does not appear correctly, refresh the browser or
clear the browser cache as the previous iteration of the image may have been saved by the browser. This
action can be found in various places in browsers' settings and for some browsers/platforms, this can be
accomplished by click CTRL+F5 or CTRL+ the Reload icon. Otherwise the edited image may not appear as
expected.
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Show/Hide Block Elements
Show Elements Overview
The Show/Hide Block Elements icon on the WYSIWYG Toolbar enables the ability to toggle the view
of the WYSIWYG Editor. Click the icon to show the view or to hide it. Toggling displays block elements
encapsulated within rectangles defined with thin, dashed lines and identified them with the label of the
HTML element being used.

Show/Hide Block Elements Icon

Location of Icon on the WYSIWYG Toolbar

Using Show/Hide Block Elements
The encapsulation rectangles show the applied format element; for example, a P label identifies
the paragraph element, <p></p>, and HGROUP represents the application of a Heading Group.

Styling can be applied by using the Format or the Styles drop-down; however, only elements listed on the
Format drop-down are shown in the block element view. The Styles drop-down applies classes. Elements
listed on the Format drop-down are built-in; elements listed on the Styles drop-down can be added to reflect
what has been defined in a style sheet. The list available on the Format drop-down also depends upon the
schema used. For example, when enabling HTML5 Schema for a site, the following are available on the
Format drop-down:

• Paragraph
• Address
• Pre
• H1 – H6
• Block Quote
• Section
• Article
• Heading Group
• DIV
• Aside
• Figure

When HTML5 Schema is not enabled, the WYSIWYG defaults to XHTML. The following are available on the
Format drop-down:

• Paragraph
• Address
• Preformatted
• H1 – H6

In both cases, when the Show/Hide view is toggled to show, the corresponding block elements are shown in
the encapsulated and labeled view.
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For more information about the Format drop-down and the usage for HTML5 Schema:

Format Drop-Down

Example of Show/Hide Block Elements

 

 

 

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-2/format-dropdown.html
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CodeProtect
CodeProtect Overview
Script code blocks may be safely inserted into an editable region using CodeProtect. These script code
blocks are represented in the editor interface by a red question mark icon. This icon is shown in the figure
below:

 

CodeProtect regions may be inserted or edited by clicking on the CodeProtect button in the toolbar. This
opens the CodeProtect editor window.

 

Whether creating a new CodeProtect region or editing a new one, code blocks are entered into the
CodeProtect window, as shown in the following figure:
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Click the Update button to insert the code block as a red CodeProtect icon in the editor. New CodeProtect
regions are inserted at the current cursor location in the editor.

Limitations
The purpose of CodeProtect is to allow users the ability to insert PHP, ASP, or JSP code into an editable
region. ASP and JSP code must use the <%    %> processing instruction notation. PHP must use the <?
php   ?> or <?    ?> notation.

If the page is a publish control file (PCF) or any other type of XML implementation, then only PHP code
blocks are allowed. This is because the ASP and JSP <%  %> tagging is invalid XML. PHP blocks, on the
other hand, are valid XML preprocessing instructions. XSL transformation of PHP code blocks is successful,
but it will fail for ASP and JSP.
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Toolbar Row 3
Toolbar Row 3 Overview
The available tools on the third row of the toolbar are those available for inserting and editing tables and
forms within the WYSIWYG Editor. For both tables and forms, the additional features are available after the
initial table or form has been inserted on the page. Place the cursor within the element and the editing tools
will become available.

 

In addition to the Insert/Edit Table tool, other table editing functions include those for defining the properties
for table cells and rows, and for inserting and deleting rows and columns.

As with other functionality, right-clicking within a table provides a shortcut menu for table editing and
formatting.

Example of Shortcut Menu

Table Tools

Icon Tool Description

Insert/Edit Table To insert a table, position the
cursor then click the Insert/Edit
Table icon. The Insert/Edit Table
dialog includes several fields that
can be used to define the table
including:

• Columns: Number of columns
in table

• Rows: Number of rows in
table

• Cell Padding: Padding
around cells

• Cell Spacing: Spacing
between cells

• Alignment: The alignment of
the content within the cells

• Border: Thickness of the
border around the cells

• Width: Width of table
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Icon Tool Description

• Height: Height of the table
• Class: A class defining the

styling of the table
• Table Caption: Choose

whether or not to have a
caption above the table

Fill in table details, then click OK
to insert table, or click Cancel to
return to the editor.
For more information about
tables:

• Insert/Edit Table
• General tab
• Advanced tab

Table Row Properties Edit the alignment, background
color and several other
properties of the rows of the
table.

Table Cell Properties Edit the alignment, background
color and several other
properties of the cells of the
table.

Insert Row Before To insert a row above another
row, click inside the row cell the
new row is to precede, then click
the Insert Row Before icon.

Insert Row After To insert a row below another
row, click inside the row cell the
new row is to follow, then click
the Insert Row After icon.

Delete Row To delete a row, click inside the
row to be removed, then click the
Delete row icon.

Insert Column Before  To insert a column before
another column, click inside the
column cell the new column is
to precede, then click the Insert
Column Before icon.

Insert Column After  To insert a column after another
column, click inside the column
cell the new column is to follow,
then click the Insert Column After
icon.

http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-3/tables.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-3/tables.html
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Icon Tool Description

Delete Column  To delete a column, click inside
the column to be removed, then
click the Delete Column icon.

Split Merged Table Cells  To split cells that have previously
been merged, select the cell then
click the Split Merged Table Cells
icon.

Merge Table Cells To merge cells, highlight the
cells to be merged, then click the
Merge Table Cells icon.

 
Form Tools
The Form tools build the client interface for the form. The site developer will need to provide the server side
form processing code. The form tools available from within the WYSIWYG are not the same as the Form
Asset provided with the Live Delivery Platform product: Live Delivery Platform Forms.

Icon Tool Description

Insert/Edit Form Create or edit the form. When
creating a new form, set all
attributes needed for the form to
function properly.

 

Delete Form Highlight the form for deletion
and click the Delete Form icon.

 

Insert/Edit Input Element Insert or modify input field such
as checkboxes, icons, or events.

 

Insert/Edit Select Element Insert or modify selection drop
down elements.

 

Insert/Edit Textarea Element Insert or modify textarea
elements.

For more information about forms, see the Forms Tutorial or Forms Reference.

http://support.omniupdate.com/oucampus10/reusable-content/assets/form-asset.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-3/formstutorial.html
http://support.omniupdate.com/oucampus10/pages/wysiwyg/toolbar-row-3/formsreference.html
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Adding Tables in the WYSIWYG Editor

Tables Overview
The default toolbar of the WYSIWYG Editor includes the standard tools for editing tables such as the ability
to insert, delete, and define rows and columns, as well as merge or split table cells.

Various table elements and attributes can be added and defined via the WYSIWYG both when adding a
new table or after. This is accomplished with fields available by clicking the Insert/Edit Table icon.

These include the number of columns and rows, table width and height, and a table border, for example.
Both a General tab and an Advanced tab are available for defining the table elements. If a Level 10
administrator has configured access settings to allow for source access, the Edit HTML Source icon can be
used to view and edit the HTML source code for the table elements.

Additionally, the class selector can be used to assign a class to a table to define the styling for the table as
has been defined within a CSS style sheet.

The Insert/Edit Table dialog contains a few differences depending upon the schema in use for the
WYSIWYG, which is an option that can be set by an administrator. For example, when HTML5 schema is
selected for a site, certain invalid HTML attributes are removed. Additionally, the markup for HTML5 schema
differs from previous HTML markup iterations as many elements and attributes have become changed,
obsolete, or invalid. If HTML5 schema has not been enabled, the XHTML/HTML schema that is used by the
WYSIWYG Editor does not delete the HTML5 elements, such as section and article, but there is not an easy
way for users to add these elements to the page without going into the source code or using a snippet or
asset. The XHTML schema also allows for attributes that have been identified as invalid in HTML5 but not in
XHTML. When the HTML5 schema is enabled, invalid attributes are removed.

Inserting a Table
• To insert a table, select the desired location, then click the Insert/Edit Table icon.

A simple table can be created by just specifying the number of rows and columns for the table. For more
information about the additional general and advanced properties, see:

Table: General Properties

Table: Advanced Properties

Table Formatting Tools
The table formatting tools are available after a table is inserted and when the cursor is within the table.

Icon Description

 Table Row Properties: Defines the row properties
such as alignment, height, and background color.
The drop-down can then be used to apply the
updates to the current row, all odd rows, all even
rows, or all rows.
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Icon Description

 Table Cell Properties: Defines the cell properties
such as alignment, width, height, and background
color. The drop-down can then be used to apply
the updates to the current row, all odd rows, all
even rows, or all rows.

 Insert Row Before and Insert Row After: Use the
first icon to insert a row above the row the cursor is
in, and use the second icon to insert a row below
the row the cursor is in.

 Delete Row: Deletes the row the cursor is in.

 Insert Column Before and Insert Column After:
Use the first icon to insert a column to the left of
the column the cursor is in, and use the second
icon to insert a column to the right of the column
the cursor is in.

 Delete Column: Deletes the column the cursor is
in.

 Split Merged Table Cells: To split cells that have
previously been merged, select the cell then click
the Split Merged Table Cells icon.

If within a merged cell (contains a colspan and/
or rowspan), this will remove the colspan and/
or rowspan attributes to result in individual cells
matching the table’s non-merged configuration.

 Merge Table Cells: To merge cells, highlight the
cells to be merged, then click the Merge Table
Cells button.

Merges the selected table cells into one cell by
adding the necessary colspan and/or rowspan
attributes. It is also possibly to place the cursor in
the upper, left most cell, and then click the Merge
Table Cells icon. A prompt will appear in which
the desired number of columns and/or rows to be
merged needs to be entered.

When merging cells, all of the content currently
within the cells remains.



OU Campus Adding Tables in the WYSIWYG Editor Page 61 of 91

Table: General Properties
The Insert/Edit Table dialog is displayed with several available fields on the General tab and Advanced tab
that can be used for defining the table.

Example of General Properties (Available for both XHTML and HTML5 schema)

Comparison of General Properties with XHTML and HTML5 Schema

Field XHTML/HTML 4.01 HTML5 Schema

Columns: Defines the number of
columns for the table

Adds the corresponding number
of <td></td> elements.

Adds the corresponding number
of <td></td> elements.

Rows: Defines the number of
rows for the table

Adds the corresponding number
of <tr></tr> elements.

Adds the corresponding number
of <tr></tr> elements.

Cell Padding: Defines padding
within the cell between the
border and the text

cellpadding="8" Obsolete attribute on table. CSS
should be used instead. For
example: td { padding:5px; }

Cell Spacing: Defines spacing
between cells

cellspacing="5" Obsolete attribute on table. CSS
should be used instead. For
example: border-spacing.

Border: Defines the thickness of
cell border

 

border="5" Can be written as an attribute
only with a value of 0 or 1.
When defined with other border
attributes written with inline CSS;
e.g., <table style="border: 12px
solid #f15b0d;" border="12">

WHATWG suggest border-width
can be used instead.
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Field XHTML/HTML 4.01 HTML5 Schema

Width: Defines the width of table,
defaults to pixels, but percent
can also be used

style="width: 220px; background-
color: #ee4510;"

 <table style="width: 220px;">

Height: Defines the height of
the table, defaults to pixels, but
percent can also be used

style="height: 500px;
background-color: #ee4510;"

 <table style="height: 220px;">

Class: Defines a class to be
applied to the table; a class that
has been added to the styles
menu can be selected from the
drop-down, or value can be
selected and a class can be
entered manually, and if the
class has been defined in the
CSS that is being called the
styling will be applied.

<table class="green">  <table class="green">

Table Caption: Adds the caption
element above the table

<table><caption>TABLE
CAPTION</caption>
<tbody>
<tr>
<td>cell data</td>
<td>cell data</td>
</tr>
<tr>
<td>cell data</td>
<td>cell data</td>
</tr>
</tbody>
</table>

<table><caption>TABLE
CAPTION</caption>
<tbody>
<tr>
<td>cell data</td>
<td>cell data</td>
</tr>
<tr>
<td>cell data</td>
<td>cell data</td>
</tr>
</tbody>
</table>

Table: Advanced Properties
The Advanced tab includes the Advanced Properties, which includes fields based on the schema employed.
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Example of Advanced Properties for XHTML

As shown below, Advanced Properties for HTML5 do not include:

• Summary
• Frame
• Rules

Example of Advanced Properties for HTML5
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Field XHTML/HTML 4.01 HTML5 Schema

ID: Adds the id attribute to the
<table> start tag with the value
defined in the field

<table id="t-id-21"> "The id global attribute is now
allowed to have any value, as
long as it is unique, is not the
empty string, and does not
contain space characters." For
example, <table id="t-id-21">

Summary: Adds the summary
attribute to the <table> start tag
with the value defined in the field

summary="added value" Obsolete attribute on table.

Style Displays inline CSS written with
the style attribute as defined by
other fields.

Displays inline CSS written with
the style attribute as defined
by other fields. For example,
when border, border color, and
background color are defined:
border-color: #5ca366; border-
width: 1px; background-color:
#828e71;

Language Code <table lang="sl">

This attribute specifies the
base language of an element’s
attribute values and text content.
RFC1766 defines and explains
the language codes that must be
used in HTML documents.

Specifies the primary language
for the element's contents and
for any of the element's attributes
that contain text. Its value must
be a valid BCP 47 language tag,
or the empty string.

The lang attribute in the XML
namespace is defined in XML.

Background Image background-image: url('/images/
purple.png');

background-image: url('/images/
purple.png');

Frame Could be used to identify which
parts of a  border around a
table are shown. For example,
selecting lhs in the Frame drop-
down identifies that the left-hand
side of the table border is visible:

frame="lhs"

Obsolete attribute on table.
CSS can be used instead; for
example: border-color:black and
border-style.

Rules Could previously be used to
identify the borders of a table cell
to be shown, similarly to frame.
For example,

rules="rows";

provides cell border style with the
appearance of horizontal rules.

Obsolete attribute on table. CSS
can be used: border-color:black
and border-style on the table's
appropriate elements

http://www.ietf.org/rfc/bcp/bcp47.txt
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Field XHTML/HTML 4.01 HTML5 Schema

Language Direction For purposes of
internationalization, language
direction can be specified as
right-to-left or left-to-right with the
dir attribute:

dir="rtl"

 
<table id="id" style="border-
width: 10px; border-color:
#f0f40a; background-color:
#6e918c;" summary="summary"
border="10" cellspacing="5"
cellpadding="125">
<caption>&nbsp;</caption>

Border Color: Launches the color
picker to define the table border

Defined by a style attribute; e.g.,
border-color: #f0f40a).

Written as inline CSS:
style="border-color: #6e918c;"

Background Color: Launches the
color picker to define the table
background,

In this schema, background
color is not added as bgcolor,
but rather as defined by
a style attribute: e.g.,
style="background-color:
#6e918c;" 

Obsolete as an attribute
(bgcolor). Written as inline
CSS: style="background-color:
#6e918c;"

Example of Frame Attributes for XHTML/HTML Schema

 



OU Campus Adding Tables in the WYSIWYG Editor Page 66 of 91

Example of Rules Attributes for XHTML/HTML Schema

 

Applying a Class to a Table
Any number of tables can be defined in CSS as a class. When inserting a table in the WYSIWYG, the class
can be selected or entered from the Class drop-down. The class needs to be added to the Styles drop-
down file in order for it to be listed on the Class drop-down on the Insert/Edit Table dialog. A class that has
been defined in CSS, but not added to the Styles drop-down, can be entered manually by clicking value and
typing the name of the class. If a user has source code access, the class and its value can be added in a
source view.

Applying a Class to a Table
1. Define the class in the CSS file. The location for the file is dependent upon the implementation; for
example, _resources/css/main.css. Here is an example of CSS that creates a table centered on the page
with centered text that has a gradient background and a box shadow.
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/* Table Design */
.centered {
overflow:hidden;
border:1px solid #d3d3d3;
background:#DEDEDE;
width:100%;
margin:5% auto 0;
-moz-border-radius:5px; /* FF1+ */
-webkit-border-radius:5px; /* Saf3-4 */
border-radius:5px;
-moz-box-shadow: 0 0 4px rgba(0, 0, 0, 0.2);
-webkit-box-shadow: 0 0 4px rgba(0, 0, 0, 0.2);
color:#000000;
}
.centered thead{
background: -moz-linear-gradient(100% 20% 90deg, #e8eaeb, #ededed);
background: -webkit-gradient(linear, 0% 0%, 0% 20%, from(#ededed),
to(#e8eaeb));
padding:18px 28px 18px; text-align:center;
padding-top:22px; background:#e8eaeb;
}
.centered tr th {padding:20px; text-align:center; }
.centered tbody td{
background: -moz-linear-gradient(100% 25% 90deg, #fefefe, #f9f9f9);
background: -webkit-gradient(linear, 0% 0%, 0% 25%, from(#f9f9f9),
to(#fefefe));
padding:18px 28px 18px; text-align:center;
}
.centered tbody tr:nth-child(even) td{
background: #DEDEDE; /* Old browsers */
background: -moz-linear-gradient(top,  #fefefe 0%, #dedede 100%); /* FF3.6+ */
background: -webkit-gradient(linear, left top, left bottom, color-
stop(0%,#fefefe), color-stop(100%,#dedede)); /* Chrome,Safari4+ */
background: -webkit-linear-gradient(top,  #fefefe 0%,#dedede 100%); /*
Chrome10+,Safari5.1+ */
background: -o-linear-gradient(top,  #fefefe 0%,#dedede 100%); /* Opera 11.10+
*/
background: -ms-linear-gradient(top,  #fefefe 0%,#dedede 100%); /* IE10+ */
background: linear-gradient(top,  #fefefe 0%,#dedede 100%); /* W3C */
filter: progid:DXImageTransform.Microsoft.gradient( startColorstr='#fefefe',
endColorstr='#dedede',GradientType=0 ); /* IE6-9 */
box-shadow: 0 1px 0 rgba(255, 255, 255, 0.8) inset, 0 -2px 0 rgba(0, 0, 0, 0.1)
inset, 0 0 10px rgba(255, 255, 255, 0.5) inset, 0 0 0 1px rgba(0, 0, 0, 0.1), 0
2px 4px rgba(0, 0, 0, 0.2);
}
.centered tbody tr:nth-child(odd) td{
background: #f9fcf7; /* Old browsers */
background: -moz-linear-gradient(top,  #f9fcf7 0%, #f5f9f0 100%); /* FF3.6+ */
background: -webkit-gradient(linear, left top, left bottom, color-
stop(0%,#f9fcf7), color-stop(100%,#f5f9f0)); /* Chrome,Safari4+ */
background: -webkit-linear-gradient(top,  #f9fcf7 0%,#f5f9f0 100%); /*
Chrome10+,Safari5.1+ */
background: -o-linear-gradient(top,  #f9fcf7 0%,#f5f9f0 100%); /* Opera 11.10+
*/
background: -ms-linear-gradient(top,  #f9fcf7 0%,#f5f9f0 100%); /* IE10+ */
background: linear-gradient(top,  #f9fcf7 0%,#f5f9f0 100%); /* W3C */
filter: progid:DXImageTransform.Microsoft.gradient( startColorstr='#f9fcf7',
endColorstr='#f5f9f0',GradientType=0 ); /* IE6-9 */
box-shadow: 0 1px 0 rgba(255, 255, 255, 0.8) inset, 0 -2px 0 rgba(0, 0, 0, 0.1)
inset, 0 0 10px rgba(255, 255, 255, 0.5) inset, 0 0 0 1px rgba(0, 0, 0, 0.1), 0
2px 4px rgba(0, 0, 0, 0.2);
}
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2. Add the class in the styles.txt file. Typically,  _resources/ou/editor/styles.txt. For the class defined above,
add:

.centered     TableNice

The space between the two words must be created by using the Tab key.

3. Click the Insert/Edit Table icon on the WYSIWYG Toolbar.

4. From the Class drop-down, select TableNice (the friendly name that was added to label the class).

Alternatively, ff the class was defined, but not added to the Styles drop-down, from the Class drop-down,
click (value) and enter the name of the class (without the period).
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Form Tutorial
Form Tutorial Overview
Building a form in OmniUpdate is a simple process using the WYSIWYG editor. Follow the Form Tutorial
outlined below to get started on building form elements. Form elements are elements that allow the user to
enter information into a form (like text fields, textarea fields, drop-down menus, radio buttons, checkboxes,
etc.).  

Creating a Form
The functionality for creating WYSIWYG forms can be enabled by a Level 10 administrator. A set of toolbar
icons similar to the ones below will show up in the WYSIWYG editor's toolbar:

These toolbar buttons allow for the creation of an HTML form and the ability to add elements to it. A few of
the most common elements are text input boxes, radio buttons, check boxes, and submit buttons.

To edit a currently existing form field, first click anywhere inside the form to allow the cursor to recognize the
form itself, then double-click the form field to which to make changes. Then there is the ability to click the
form editor buttons in the toolbar above.

Just remember, the forms toolbar does not create the backend functionality that to process the information
once the form is submitted. Some sort of script or program must be installed on the server for the form to
process and interpret the information.

This tutorial exemplifies building a simple survey form that contains text fields, a drop-down list, radio button,
checkboxes and a button.

Insert a Form
To insert a form into a page:

1. Click on the Insert/Edit Form button in the WYSIWYG toolbar.

2. This will bring up the Insert/Modify Form dialog box. Name the form and set up other properties. For the
purposes of this tutorial, the focus is on the General Tab for this form initially. Properties include: 

• Name: A name for the form (example: testform1)
• Action: The form#s action attribute defines the name of the file to send the content to the

server (example: html_form_submit.asp)
• Method: Select the method for the action (example: POST)
• Target: The Target field indicates which frame in a set of frames to send the results to. This

attribute can be used so that the form is always visible even as the form results are displayed and
redisplayed (example: TargetFrame)

• Encryption Type: Type of encryption for the target (example: None)
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For more information and tutorials about forms, see: 

Forms Tutorial

W3Schools Forms

3. Once the form is named and parameters added, click Insert. Note that there is now a dotted outline of the
form on the page.

http://www.htmlcodetutorial.com/forms/
http://www.w3schools.com/html/html_forms.asp
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4. Click inside the form and notice the form action buttons in the WYSIWYG toolbar are now active.

5. Insert form elements such as:

• Text fields
• Drop-Down lists
• Radio buttons
• Checkboxes
• Buttons

Add Text Fields
Once a form has been inserted onto the page, a variety of form elements can be added. To add a text field:

1. Click the  Insert/ Edit Form Input Element icon to add text fields.

 

2. This will open the Insert/Modify Form dialog. From the Type drop-down, select the Text element. 
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3. Give it a descriptive name such as firstName.

4. Set up the first text field with the desired parameters, such as:

• Name: firstName
• Value: firstName 
• Size: 200
• Width: 200
• Height: 20
• Border: #de2051
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Note: All Values must be one word only with no spaces.

5. To select colors for border or background color, click inside the color box to see a hex color picker tool.

 

6. Click Insert and notice that a new text field has been inserted into the new form on the page.
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To create a simple survey form, use the directions above to create three text fields:

• First name
• Last Name
• Email Address.

Add a Drop-Down List
To create a drop-down list:

1. Click the Insert/Edit Select Element icon. The following dialog box is displayed. 
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2. Click the green add button to enter selection options.  As an example, use the following data for list:
pizza, ice cream, hamburgers, and twinkies.

3. Include the additional parameters, for example:

• Number of option rows: 1
• Width: 200
• Height: 20
• Border color: #1759e8

4. After filling out the dialog box with data, click Insert to place the new drop down list into the form.
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5. Click Save. Notice the drop down list for favorite foods. It should look similar to the image below.

Add Radio Buttons
To create a radio button:

1. Click the  Insert/Edit Form Input Element icon

2. This will open the Insert/Modify Form dialog. From the Type drop-down, select radio button.

3. As an example, set it up with the following parameters:

• Name: Yes
• Value: Yes
• Type: radio
• Size: 20
• Width: 20
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4. Click Insert and then add a sentence next to the radio button. For example:

• Yes - Please send more information regarding desserts. 

Note: Multiple radio buttons only work if they all have the same name attribute. If creating more than one
radio button, please use the same name attribute for each button.

Add a Checkbox
The next form element that can be created is a checkbox. To create a checkbox:

1. Click the Insert/Edit Form Input Element icon.

2. This will open the Insert/Modify Form dialog. From the Type drop-down, select checkbox. 
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3. As an example, set it up with the following parameters:

• Name: bbq
• Value: bbq
• Type: checkbox
• Size: 20
• Width: 20

Note: Always remember to keep names and values lowercase and all one word. Below is an example of
what the dialog box will look like with the data filled out for a checkbox.

4. Click Insert to preview how the checkbox will look in the form.
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5. Repeat the above steps to create more checkboxes until the form looks similar to the screenshot below.

Note: It is very important to keep in mind that when using checkboxes, the user may select more than one
checkbox, but when using radio buttons the user may only select one. Additionally radio buttons only work if
they all have the same name attribute. 

Create a Submit Button
To create a submit button:

1. Click the Insert/Edit Form Input Element icon.

2. This will open the Insert/Modify Form dialog. From the Type drop-down, select submit button.
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4. As an example, set it up with the following parameters:

• Name: submit
• Value: submit
• Type: submit button
• Size: 40
• Width: 100
• Height: 25 

5. Clicl Insert.   
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Process Form Data
Now that the basic form is completed, the next step is to process the form data.

Below are some links that discuss form processing:

Net Mechanic

Web Cheat Sheet

For more information and tutorials on Forms:

HTML Code Tutorial: Forms 

http://www.netmechanic.com/news/vol5/beginner_no19.htm
http://webcheatsheet.com/ASP/process_form_data.php
http://www.htmlcodetutorial.com/forms/
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Forms Reference (WYSIWYG)
Overview
The Insert/Edit Form tool is available within the WYSIWYG Editor, if configured to be available on the
toolbar in use. Once a form has been initially created and added to a page, the other form tools on the
toolbar become available.

Insert/Edit Form: General Tab
The General tab is displayed by default after clicking on the Insert/Edit Form tool within the WYSIWYG
Editor.

Icon Description

Insert/Edit Form tool

Insert/Edit Form: General Tab

 

Auto-validate: Checks to make sure that the information is input correctly
Name: Input a name for the form
Action: Where the data in the form will be submitted
Method:

• POST: The form data will be sent as an HTTP post transaction
• GET: The form data will be sent in the URL of the resulting page

Target: Specifies where the resulting page will be opened
Encryption type:

• None: No encryption
• multipart/form-data: 
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Class: Gives a form a class for use in CSS or JavaScript 

Insert/Edit Form: Advanced Tab
The Advanced tab presents further options for editing forms with the Insert/Edit Form tool within the
WYSIWYG Editor.

Icon Description

Insert/Edit Form tool

Insert/Edit Form: Advanced Tab

Id: A unique id for the form
onsubmit: Sets a script to execute when the form is submitted
onreset: Sets a script to execute when the form is reset
Summary: Summarize the content of the form
Style: Sets any inline styling for the form

Insert/Edit Form: Hidden Fields Tab
The Hidden Fields tab presents a way for users to add a hidden filed for a form with the Insert/Edit Form tool
within the WYSIWYG Editor.

Icon Description

Insert/Edit Form tool
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Insert/Edit Form: Hidden Fields Tab

Hidden Fields: Inserts an input that can neither be seen nor edited by the user
Name: Identifies the input for processing after submission
Value: Specifies the value that is submitted

Deleting a Form  
Position the cursor within the form to be deleted and click the Delete Form tool on the WYSIWYG toolbar.
This will delete the content within the form as well.

Icon Description

Delete Form tool

Inserting an Input Element   
Once a form is created an input element for a form can be added. As many as needed can be added.

Icon Description

This is the Insert/Edit Input Element icon.
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Insert/Edit Input Element: General Tab

• Name: Identifies the input for processing after submission
• Value: Varies with the type of input

• For text input, defines the default value
• For checkboxes and radio buttons, defines the value that will be submitted
• For buttons, defines the test that is shown on the button

Type:

• text: Gives a text field
• checkbox: Gives a checkbox
• radio: Gives a radio button
• button: Gives a normal button
• file: Gives a file upload field
• masked password: Gives a text field where the characters will be represented by bullets
• submit button: Inserts the button to submit the form
• reset button: Inserts a button that will empty/reset all of the form elements

Size: Specifies the size of the element. Only affects text, file, and password types
Height: Specifies the height of the element
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Width: Specifies the width of the element
Background image: Inserts a background image for the element
Border color: Gives the element a border of the specified color
Background color: Gives the element a solid background of the specified color
Class: Gives the element a class for use in CSS or JavaScript

Inserting an Input Element: Advanced Tab
Once a form is created an input element for a form can be added. As many as needed can be added. The
Advanced tab provides additional fields for defining a form element.

Icon Description

This is the Insert/Edit Input Element icon.

Insert/Edit Input Element: Advanced Tab

Id: Gives the element a unique id
onfocus: Executes a script when the element comes into focus
onblur: Executes a script when the element goes out of focus
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onchange: Executes a script when the element is changed
onselect: Executes a script when the element is selected
onclick: Executes a script when the element is clicked
onkeyup: Executes a script when a key is pressed
onkeydown: Executes a script when a key is released
Maxlength: Specifies the maximum number of characters that can be input. Only for text and password
types
Required: Specifies whether the element is required for the form to be submitted
Checked: Specifies whether a checkbox or radio button will be checked when the form loads
Disabled: Specifies whether the element is disabled
Source: Specifies an image to display as the submit button
Summary: Summarizes the element
Style: Specifies any styling that is applied to the element 

Inserting a Select Element
In addition to input elements, select elements can also be added to a form.

Icon Description

Insert/Edit Select Element icon.
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Insert/Edit Select Element: General Tab

Name: Gives the select element a name
Name or ID: The input that is submitted for the selected option
Value: The value that is displayed for the selected option
Default Selected Value: The value that will be displayed by default
Multiple Selections Allowed: If checked, allows a user to select multiple options at once
Number of Option Rows: Specifies the number of options that are visible at any one time
Width: Specifies the width of the select element
Height: Specifies the height of the select element
Background image: Specifies an image to be shown in the background of the select element
Border color: Specifies the color for the border of the element
Background color: Specifies the color of the background of the element
Class: Specifies the class of the element for use in CSS and JavaScript
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Insert/Edit Select Element: Advanced Tab

Id: Gives the element a unique ID
onfocus: Specifies a script which will run when the element is in focus
onblur: Specifies a script which will run when the element looses focus
onchange: Specifies a script which will run when the element is changed
onselect: Specifies a script which will run when the element is selected
onclick: Specifies a script which will run when the element is clicked
Required: Specifies whether this element is required to complete the form
Disabled: Specifies whether this element is disabled
Summary: Summarizes the content of the element
Style: Specifies any styling of the element
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Inserting a Textarea
Another type of form element that can be added is a textarea.

Icon Description

Insert/Edit Textarea icon.

Insert/Edit Textarea: General Tab

Name: Gives the element a name
Value: Specifies the default text for the element
Rows: Specifies the number of visible rows in the text area
Columns: Specifies the number of visible columns in the text area
Background Image: Specifies a background image for the text area
Border color: Specifies the color of the border of the text area
Background color: Specifies the color of the background of the text area
Class: Gives the element a class for use in CSS and JavaScript
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Insert/Edit Textarea: Advanced Tab

Id: Gives the element a unique Id
onfocus: Specifies a script to run when the element is in focus
onblur: Specifies a script to run when the element looses focus
onchange: Specifies a script to run when the element is changed
onselect: Specifies a script to run when the element is selected
onclick: Specifies a script to run when the element is clicked
onkeyup: Specifies a script to run when a key is released
onkeydown: Specifies a script to run when a key is pressed
Maxlength: Specifies the maximum number of characters allowed in this text area
Required: Specifies whether this element is required to complete the form
Disabled: Specifies whether this element is disabled
Summary: Summarizes the content of this text area
Style: Specifies any styling for this element


